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HRIS Core Function 

Logging In 

Before you can login to the Fusion Human Resources Information System (HRIS) for the first time, 

you receive an email from “donotreply@oracle.com” with a subject line of “New Account 

Information”. This email contains your User ID, a temporary password, and a link to the HRIS 

Fusion login page. After logging in for the first time, you will change your password and register 

some challenge questions. 

If you have not received your login credentials (or have forgotten your user name), email HRIS 

Support at HRIS@unitedlex.com, or contact your system administrator. 

 India – Sunil Kumar (+91-9818637887)

 US – Shweta Bhatia (913-209-4820) or James Wareham (913-333-3437)

1. To login, go to https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome.

2. Enter your HRIS user name and Fusion password and click on Sign In.

mailto:donotreply@oracle.com
mailto:HRIS@unitedlex.com
https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome


HRIS CORE FUNCTION:  GETTING STARTED  

 2 HRIS – Employees’ User Guide

The HRIS Fusion Welcome Screen is displayed. 

 

On some screens, the icons on the Welcome Screen are available on a horizontal bar 

across the top the page. Their function is the same as on the Welcome Screen. 

 

If the horizontal bar is not visible, click on the home icon to display the horizontal bar. 

 

Getting Started 

In addition to this User Guide, you can view online videos for additional training concerning your 

personal information, the directory, and requesting absences. 
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1. To view the videos, from the Welcome Screen (or the horizontal bar of other screens), click 

on Getting Started. 

 

2. You can view the available videos by hovering your mouse over the squares at the bottom 

of the screen. 

 

3. To watch the video (if permitted at your location), click on the square and then click on the 

play icon. 

Changing Your Time Zone 

The default time zone for the Fusion HRIS system is CST. If your local time zone is not CST, or if 

you are traveling across time zones, it may be necessary to switch the Fusion application to the 

appropriate time zone. 

1. Use the pulldown menu under your name and click on Set Preferences…. 
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2. Under Preferences, click on Regional. 

 

3. Use the Time Zone pulldown menu to select the appropriate time zone. 

 

Note: For the India offices, select the Calcutta time zone. 

 

4. Click on Save. 

 

Viewing and Editing Personal Information 

You can use the Personal Information page to view and edit personal information, such as, contact 

information and documents. 

After you have made your edits, any change requests regarding your own personal contact 

information, such as your address, are forwarded to Human Resources for approval, and you will 

not be able to make any additional changes to your personal information until the first changes are 

approved. 
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Changes involving Contact Information and Documents are updated immediately and are not 

forwarded to HR. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Personal 

Information. 

 

Your My Details page is displayed. 

 

2. To make changes or additions to your personal information, click on Edit. 
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The Contact Information page is displayed. 

 

3. To view or edit other personal information pages, click on the My Information bar. 

 

Note: Contact Information contains your own personal information. Contacts contains 

others’ information. 

Contact Information 

Contacts 

Documents 
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4. To edit a page, click on the pencil icon. 

 

5. To add family members and/or an emergency contact, click on the Contacts icon , and 

then click on . Provide information about the contact, including phone numbers. At a 

minimum, you must fill out the contact’s relationship to you, and their first and last name. 

 

Note: All employees are required to have an emergency contact listed within HRIS. Be sure 

to add your emergency contact’s phone number(s). 
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6. To provide information concerning your documents (citizenship papers, driver’s licenses, 

passports, visas, and permits), click on the Documents icon , and then click on the  

next to the type of document about which you want to provide information. 

 

7. After making your edits, click on Save and Close. 

 

Viewing Your Compensation 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Personal 

Information. 

 

Your My Details page is displayed. 
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2. Click on the Compensation icon  . 

 

Your salary information is displayed. 

 

Note: India employees can view their bank account information by clicking on the Pay 

icon  . 

Viewing Leave/Paid Time Off (PTO)/Absence Balances – US/UK 

Salaried employees in UnitedLex Corp and all UK employees can view any absence balances for 

which they may be eligible from the Accrual Balances list. Non-exempt employees in UnitedLex 

Corp must continue to use their current process to view absence balances. For UnitedLex India 

employees, see Absence Management - India Employees on page 16. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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Note: You can also access your dashboard by clicking on the Navigator icon along the top 

of the page. 

 

Your Dashboard is displayed. 

2. Click on My Portrait. 

 

3. Click on Manage Absence Records. 
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Your Accrual Balances list is displayed. The plans available in the Accrual Balances list vary 

by location. 

 

Requesting Leave, PTO, or Other Types of Absences 

Salaried employees in UnitedLex Corp and all UK employees can request absences using My 

Portrait in the Fusion HRIS system. Non-exempt employees in UnitedLex Corp, must continue to 

use their current process to request absences. For UnitedLex India employees, see Absence 

Management - India Employees on page 16. 

Note: You can also request an absence retroactively for unplanned absences such as illnesses or 

bereavement. 

1. From the Welcome Screen (or any other screen), click on Navigator. 

 

Your Dashboard is displayed. 
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Note: You can also access your Dashboard from other pages by clicking on the Navigator 

icon along the top of the page. 

 

2. Click on My Portrait. 

 

3. Click on Manage Absence Records. 

 

The Manage Absence Records page is displayed. 
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4. Click on Add. 

 

5. Click on the Absence Type pulldown menu and select the type of absence you are 

requesting. The selections available in your pulldown list vary by location. 

 

The Add Absence Record page is displayed. 

6. Select Single day if you are requesting only one day. 

 

Note: If your absence is recurring, click on Advanced Mode > Add Weekly Recurrences. 
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7. Use the Start Date pulldown menu to select the day you want to start your absence. 

 

8. If you are requesting multiple days, use the End Date pulldown menu to select the last day 

of your absence. 

9. If you are requesting less than 8 hours, enter the Start Time and End Time. Otherwise, 

leave the default entries. 

Note: Hourly leave applies only to UnitedLex Corp employees. 

10. Optionally, enter any comments concerning your request. 

11. Use the Descriptive Information pulldown menus and select whether you will be available 

on phone and email, and then click on Submit. 

 

Note: If you save and close without submitting the request, you can later open and submit 

the request by clicking on the request date and then Submit. 

 

12. Click on OK to confirm. 
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After your request has been approved (or declined), you receive an email notification. 

 

Deleting an Absence Request 

You can delete an absence request after you have submitted it, either before or after it has been 

approved, or even after the requested date has passed (if, for example, you requested an absence 

but did not take it). 

To edit an absence request, delete the original request then add a new one. (To add a new request, 

see Requesting Leave, PTO, or Other Types of Absences on page 11.) 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your dashboard is displayed. 
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2. Click on My Portrait. 

 

3. Click on Manage Absence Records. 

 

4. Click on  to delete the request. 

 

5. Click on Yes to confirm. 

A request to withdraw approval for the absence is forwarded to your manager. 

Absence Management - India Employees 

Viewing Leave, Attendance Regularization, and Absence Balances 

UnitedLex India employees can view any absence balances for which they may be eligible from the 

Accrual Balances list.  
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1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Note: You can also access your dashboard by clicking on the Navigator icon along the top 

of the page. 

 

Your Dashboard is displayed. 

2. Click on My Portrait. 
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3. Click on Manage Absence Records. 

 

You Accrual Balances list is displayed. The plans available in the Accrual Balances List vary 

by location. 

 

Requesting Leave, Earned Leave, Causal Sick Leave, or Other Types of Absences 

India Employees can request absences using My Portrait in the Fusion HRIS system.  

Note: You can also request an absence retroactively for unplanned absences such as 

Compassionate Leave, Earned Leave and Causal Leave etc.  

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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Note: You can also access your dashboard by clicking on the Navigator icon along the top 

of the page. 

 

Your Dashboard is displayed. 

2. Click on My Portrait. 

 

3. Click on Manage Absence Records. 

 

The Manage Absence Records page is displayed. 
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4. Click on Add. 

 

5. Click on the Absence Type pulldown menu and select the type of absence you are 

requesting. The selections available in your pulldown list vary by location. 

Note: “Floating Holiday” is listed as one of the leave types. 

 

Note: You cannot apply for two leave types for the same time frame. Either cancel one 

leave type first and then apply the other leave type, or split the leave and then apply. 

6. Select Single day if you are requesting only one day. 

 

Note: If your absence is recurring, click on Advanced Mode > Add Weekly Recurrences. 
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7. Use the Start Date pulldown menu to select the day you want to start your absence. 

 

8. If you are requesting multiple days, use the End Date pulldown menu to select the last day 

of your absence. 

Your remaining balance is visible in the balance field. 

 

9. Optionally, enter any comments concerning your request. 

10. Use the Descriptive Information pulldown menus and select whether you will be available 

on phone and email, and then click on Submit. 

 

11. Click on OK to confirm. 

After your request has been approved (or declined), you receive an email notification. 
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Deleting an Absence Request  

You can delete an absence request after you have submitted it, either before or after it has been 

approved, or even after the requested date has passed (if, for example, you requested an absence 

but did not take it). 

To edit an absence request, delete the original request then add a new one. (To add a new request, 

see Requesting Leave, Earned Leave, Causal Sick Leave, or Other Types of Absences on 

page 18.) 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your dashboard is displayed. 

2. Click on My Portrait. 
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3. Click on Manage Absence Records. 

 

4. Click on  to delete the request. 

 

5. Click on Yes to confirm. 

A request to withdraw approval for the absence is forwarded to your manager. 

Requesting Attendance Regularization on No Bio Metric Days 

India Employees can request attendance regularization on no Bio-Metric days from My Portrait in 

the Fusion HRIS system.  

Note: You can also request an absence retroactively for No Bio-Metric. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your dashboard is displayed. 
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2. Click on My Portrait. 

 

3. Click on Manage Absence Records. 

 

4. Click on  to delete the request on No Bio-Metric. 

 

The cancellation must be approved by Manager before applying for any leave/Attendance 

Regularization. 
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Apply for Leave or Attendance Regularization 

5. Click on Add. 

 

6. Click on the Absence Type pulldown menu and select the type of absence you are 

requesting. 

  

7. Select Single day if you are requesting only one day. 

 

Note: If your absence is recurring, click on Advanced Mode > Add Weekly Recurrences. 

8. Use the Start Date pulldown menu to select the day you want to start your absence. 
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9. If you are requesting multiple days, use the End Date pulldown menu to select the last day 

of your absence. 

10. Use the Reason pulldown menu to select the reason for your absence. 

 

11. Optionally, enter any comments concerning your request. 

12. Use the Descriptive Information pulldown menus and select whether you will be available 

on phone and email, and then click on Submit. 

 

Using the Availability Calendar 

You can use Fusion’s Availability Calendar to quickly check the status of your absences. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your dashboard is displayed. 
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2. Click on My Portrait. 

 

3. Click on Availability. 

  

A calendar is displayed, allowing you to check the status of your absences. 

 

Important Points Concerning Absence Management 

 All Leave Accruals occur at the end of each month. 

 Because the accrual is happening at the end of a month, Earned Leave and Casual Sick 

Leave can be applied negatively (1.5 and 1, respectively). 
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 Employee will be able to apply for future-dated, non accrued leaves within the current 

calendar year. (For example, if you are entitled to 18 Earned Leave days, the days accrue at 

1.5 days per month. However, you may apply for up to 18 days leave anytime during the 

year – you do not have to wait until the leave has accrued.) 

Viewing the UnitedLex Directory 

You can use the directory to search for anyone in the UnitedLex enterprise (US, India, iRunway, 

UPS and UK) to view their organizational structure, email address, contact information, job title , 

and picture. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Directory. 

 

Your immediate organizational structure is displayed. 

 

2. To view other employees’ organizational information, click on  . 
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3. Enter the employee’s first or last name and click on  . 

 

Note: Click on Advance Search to refine your search criteria. 

A list of employees is displayed that meet your search criteria. 

4. Click on the employee’s name to view their contact information and office location, or click 

on the directory icon to view their organizational structure. 

 

5. To expand the employee’s direct reports (if any), click on the triangle below their picture. 

 

Note: You can access a matrix view of the directory by selecting Directory >  > 

Advanced Search > Organization Chart tab > View Matrix Chart. 

Editing Your Email and Phone Information 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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Note: You can also access your dashboard by clicking on the Navigator icon along the top 

of the page. 

 

Your Dashboard is displayed. 

2. Click on My Portrait. 

 

3. In the Contact Information panel, use the Edit pulldown menu to select the communication 

type you want to edit. 
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4. To enter a new phone or email address click on  . 

 

5. Enter the information and click on Save and Close. 

 

6. The updated information is displayed on your My Portrait page. 

 

Changing Your Marital Status 

You can use My Portrait to change your marital status. Do not change your name in the system until 

after you have legally changed it. 

After you have made your edits, changes to your marital status and name changes are forwarded to 

Human Resources for confirmation, and you will not be able to make any additional changes to your 

marital status or name until the first changes are approved. 
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1. From the Welcome Screen (or any other screen), click on Navigator. 

 

Note: You can also access your dashboard by clicking on the Navigator icon along the top 

of the page. 

 

Your Dashboard is displayed. 

2. Click on My Portrait. 
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3. Click on Change Marital Status. 

 

4. Use the pulldown calendar to select the date that the change was (or will be) effective. 

 

5. Use the Marital Status pulldown menu to select your new status. 
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6. If your name changed as a result of the change in marital status, click on Edit. 

 

7. Make any necessary changes to your name. 

 

8. Click on OK. 

The name change and marital status is forwarded to HR for confirmation. The change is not 

reflected in HRIS until it is approved by HR. 
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Goal Management 
Goal management consists of creating, maintaining, and tracking your goals and the tasks that 

need to be performed to complete your goals. 

You have two types of goals: 

 Performance Goals – objectives established for specific duties associated with your current 

job position that are related to the company’s overall goals. Performance goals may consist 

of one or more tasks. Your evaluations are based upon your completion of these goals. 

 Development Goals – increase your knowledge and skills related to your current or future 

job position. Attainment of these goals are not directly related to your evaluation. 

Note: BPO and iRunway employees will not be using development goals for fiscal year 

2015. The US and UK will create and approve development goals at the beginning of 

the rating period. 

Performance Goals 

Viewing and Adding a Performance Goal 

You can add new goals for yourself, or you can add a goal that already exists from the goal library. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 
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2. Under My Information, click on Goals. 

 

3. Click on the Performance Goals tab. 

 

The Performance Goals page is displayed. Your current performance goals are listed. 

 

Note: The first time you view your goals, you may already have some goals listed that were 

submitted by your manager to HR. If no goals are listed, work with your manager to 

add your goals. 



GOAL MANAGEMENT:  PERFORMANCE GOALS  

 37 HRIS – Employees’ User Guide

4. To add a performance goal, click on Add Goal. 

 

5. Perform one of the following: 

 To add a goal from the goal library - select Add from goal library and use the Goal 

Name pulldown menu to select a goal. See Searching the Goal Library on page 43 for 

instructions on using the goal library search function. 

Note: You cannot change the name of goals that have been added from the goal library. 

 

 To add a new goal - enter the goal name. 
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6. Enter a brief description of the performance goal. 

 

7. Select the goal’s priority, and enter the start date and target completion date. Both dates 

must be within the current review period so that the goal can be transferred to your 

performance document. 

 

Note: If a goal is ongoing, enter the end of the rating period for the target completion date. 

8. Select the goal’s current status. 

 

If the status is Not Started or Completed, the completion percentage is auto populated (“0” 

or “100”, respectively). 

9. If the status is In progress, select the approximate percentage of completion. 

 

Note: You may select Save at any time if you do not want to submit the goal at this time and 

want to complete it later (you will be returned to the Performance Goals page). To 

return to it later, see Completing a Draft Goal on page 50. 

10. To continue adding the performance goal, click on More Details. 
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11. A Goal Plan is a list of goals for specific roles. Goals named “Goals_[Rating Year]” are 

blank goal plans. 

If you only have one goal plan listed, leave it selected.  

 

If you have more than one goal plan listed, do not select the plan named “Goals_[Rating 

Year].” 

 

12. Click on Weight for the selected goal plan. 

 

13. Enter the weight for the goal. Total goal weights must add up to 100. 

 

14. Click on OK. 

15. Click on the Measurement expansion triangle to expand the measurement section. 
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16. Click on the Type pulldown menu and select the type of measurement that will be used to 

measure success. 

 

17. Enter a name for the measurement. 

 

18. If the measurement is quantitative, complete the following fields (if the measurement is 

qualitative, skip this step): 

 Target Type – indicate whether the target is a “no greater than” (Maximum) value, or a 

“no less than” (Minimum) value. 

 Target Value – enter the numerical value of the qualitative measurement 

 Actual Value – leave blank initially (unless you already have measurable data for the 

goal). Enter the actual value as you begin to achieve measurable results. 

 Unit of Measurement – indicate whether the target value is a Currency, a quantity 

(Number), or a Percentage. 

 

19. Enter any comments to clarify the measurement. 
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20. In the Success Criteria field, enter an explanation of how you have accomplished this 

performance goal and a summary of how your individual tasks were accomplished. To 

ensure that it is clear who wrote the comment, add your initials after the comment. 

 

Note: BPO and iRunway employees use this field to list tasks and update the 

accomplishments of the tasks. 

21. Use the Level pulldown menu to select Stretch or Target. 

 Stretch – difficult or complex goals that are outside what is normally expected. 

 Target – goals that fall under normal job responsibilities. 

 

22. Optionally, use the Category pulldown menu to select the type of company goal that is 

supported. 
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Note: You can add one or more attachments or links to additional information by clicking on 

the appropriate  link. 

 

23. Optionally, you may share the goal with another employee. The employee determines 

whether to accept the goal into their set of goals. 

a. To share a goal with another employee, click on Search and Select. 

 

b. Enter the search criteria for the employee and click on Search. 

 

c. Highlight the employee with whom you want to share the goal, and click on Done. 

d. Use the Share tasks pulldown menu to select Yes if you also want to share the 

associated tasks. 
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Note: The employee with whom you share the goal has the option of accepting or 

declining the goal. They can also edit everything except the goal name. 

24. Click on Submit (in the upper-right corner). 

 

25. Click on OK to confirm. You receive an email indicating that the goal has been forwarded to 

your manager for approval. 

You receive another email notification after your manager either approves or rejects your 

goal. 

Searching the Goal Library 

1. From the Add Performance Goal window, select Add from goal library and use the Goal 

Name pulldown menu to select Search…. 
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2. If you know a portion of the goal name or the description, enter it and click on Search. 

 

The results of the search are displayed. 

 

3. If the goal you are searching for is listed, highlight it and click on OK. 

4. To use the advanced search, click on Advanced. 

 

5. Use the search pulldown menus to select the search parameters, and then click on Search. 
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6. Highlight the goal you are searching for and click on OK. 

Accepting a Shared Goal 

Other employees, including your manager, can share goals with you. If you accept the goal, it is 

added to your list of goals. 

1. You are notified via email that a goal was shared with you. Open the email. 

 

A brief summary of the goal is displayed. 

 

2. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 
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3. Click on Goals. 

 

4. Click on the Performance Goals tab. The shared goal is displayed in the page’s right 

column. 

 

5. To accept the goal, click on it. 

 

6. Use the Add to My Goals pulldown menu and select whether the goal will be a 

Performance or Development goal. 
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7. If necessary, change the goal name and enter the start and target completion dates. 

 

8. Click on OK. You receive an email indicating that the goal has been forwarded to your 

manager for approval. 

You receive another email notification after your manager either approves or rejects your 

goal. 

Editing a Performance Goal 

You can make changes to the performance goals in your goals list. Changes that you make are 

forwarded to your manager for approval. 

Note: You cannot change the name of goals that have been added from the goal library. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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2. Click on Goals. 

 

3. Click on the Performance Goals tab. 

4. Click on the goal you want to edit. 

 

5. Make the necessary edits. 

Note: When a goal is complete, enter the date it was completed in the Actual Completion 

Date field. If the goal is ongoing, the completion date is the end of the rating period. 

6. Click on Submit (in the upper-right corner). 

 

7. Click on OK to confirm. You receive an email indicating that the edit has been forwarded to 

your manager for approval. 

You receive another email notification after your manager either approves or declines your 

edit. 
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Note: If the only edits you made were to the Measure-specific Comments field or to the 

success criteria Comments field, your manager is not notified. 

Deleting or Cancelling a Performance Goal 

You cannot delete or cancel performance goals that were assigned to you, but you can delete or 

cancel goals that you created. Also, after a goal has been used to create a performance document, 

you cannot cancel it or delete it. 

When a goal is deleted, it is completely removed from HRIS. When a goal is canceled, it remains on 

your goal list with a status of “Canceled.” 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

2. Click on Goals. 

 

3. Click on the Performance Goals tab. 
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4. Highlight the goal you want to delete. (Do not click on the name of the goal, just highlight it.) 

 

5. Use the Actions pulldown menu to select Cancel Goal or Delete. 

 

6. Click on Yes to confirm that you want to delete (or cancel) the goal. 

 

7. Click on OK to confirm. The request is sent to your manager for approval. If you requested 

to delete the goal, it remains on your list until it is approved for deletion by your manager. 

If you requested to cancel the goal, it remains on your list until it is approved by your 

manager. It then remains on your list, but its status is listed as “Canceled.” 

Sharing a Goal 

You can choose to share a goal while you are creating the goal (see Viewing and Adding a 

Performance Goal on page 35), or you can share it after the goal has been approved. After you 

share the goal with the employee, they are notified via email and can choose to accept (or reject) 

the goal. 
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1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 

2. Click on Goals. 

 

3. Click on the Performance Goals tab. 
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4. Highlight the goal that you want to share. (Do not click on the name of the goal, just highlight 

it.) 

 

5. Click on Share. 

 

6. Enter the search criteria for the employee and click on Search. 
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7. Highlight the employee with whom you want to share the goal. If you want to share the tasks 

associated with the goal, select Share tasks. 

 

8. Click on Done. 

9. Click on OK. 

Completing a Draft Goal 

A draft goal is a goal that you started to add, but instead of submitting it, you saved it. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 
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2. Click on Goals. 

 

3. Click on the Performance Goals tab. 

 

The Performance Goals page is displayed. Your current goals are listed. 

 

4. Click on the View pulldown menu and select Draft Goals. 
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5. Your draft goals are listed. Select the draft goal you want to edit. 

 

6. Complete the goal and submit it as described in Viewing and Adding a Performance Goal on 

page 35. 

Tasks 

Tasks are the action steps that need to be done in order to complete goals. You may have one or 

more tasks to support the completion of each of your performance goals. 

Tasks may be added by your manager, or you can add your own tasks, which must then be 

approved by your manager. 

Note: Currently, only US and UK employees add tasks using this method. BPO and iRunway add 

tasks using the Success Criteria field (refer to step 17 of Viewing and Adding a Performance 

Goal on page 41). 

Viewing and Adding a Task 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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2. Click on Goals. 

 

3. Click on the Performance Goals tab. 

4. Highlight the goal you for which you want to add a task. (Do not click on the name of the 

goal, just highlight it.) 

 

5. Use the Actions pulldown menu to select Add Task. 
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6. Enter a brief description of the task. 

 

7. Use the Type pulldown menu to select the task type. (Some of the task types overlap – try 

to select the one that best fits the task overall.) 

 

8. Select the task’s priority, and enter the start date and target completion date. 

 

Note: If a goal is ongoing, enter the end of the rating period for the target completion date. 

9. If the status is In progress or Overdue, select the approximate percentage of completion. 

 

10. Select the goal’s current status. 

 

If the status is Not Started or Completed, the Completion Percentage is auto populated (“0” 

or “100”, respectively). 
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11. Optionally, you can enter a link in the Related Link field that can provide additional 

information about the task. 

 

12. Enter any task comments. To ensure that it is clear when the comment was written and by 

whom, add today’s date before the comment and your initials after the comment. 

 

13. Click on Save and Close. 

14. Click on OK to confirm. 

15. To confirm that the task has been added, click on the goal’s expansion triangle to view the 

task. 

 

Editing a Task 

You can edit or make status updates to a task. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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2. Click on Goals. 

 

3. Click on the Performance Goals tab. 

4. Click on the name of the goal you for which you want to edit a task. The Goal Details page is 

displayed. 

 

5. Click on the Tasks tab. 

 

All of the tasks associated with the goal are displayed. 

6. Make the desired updates or edits to the task. 
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7. Click on Submit (in the upper-right corner). 

 

8. Click on OK to confirm. 

Deleting a Task 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

2. Click on Goals. 

 

3. Click on the Performance Goals tab. 



GOAL MANAGEMENT:  DEVELOPMENT GOALS  

 61 HRIS – Employees’ User Guide

4. Click on the name of the goal you for which you want to edit a task. The Goal Details page is 

displayed. 

 

5. Click on the Tasks tab. 

 

All the tasks associated with the goal are displayed. 

6. Locate the task you want to delete and click on the Delete button to the right of the task. 

 

7. Click on Yes to confirm that you want to delete the task. 

 

The task is deleted. 

Development Goals 

Development goals increase your knowledge and skills related to your current or future job position. 

Attainment of these goals are not directly related to your evaluation. 

Note: BPO and iRunway employees will not be using development goals for fiscal year 2015. The 

US and UK will create and approve development goals at the beginning of the rating period. 
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Viewing and Adding a Development Goal 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 

2. Click on Goals. 

 

3. Click on the Development Goals tab. 
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The Development Goals page is displayed. Your current development goals are listed. 

 

4. To add a development goal, click on Add Goal. 

 

5. Perform one of the following: 

 To add a goal from the goal library - select Add from goal library and use the Goal 

Name pulldown menu to select a goal. 

 

Note: You cannot change the name of goals that have been added from the goal library. 

 To add a new goal - enter the development goal name. 
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6. Enter a brief description of the development goal. 

 

7. Select the goal’s priority, and enter the start date and target completion date. 

Note: If a goal is ongoing, enter the end of the rating period for the target completion date. 

 

Note: You may select Save at any time if you do not want to submit the goal at this time and 

want to complete it later. However, you will be returned to the Development Goals 

page, and the goal becomes a Draft Goal. To return to it later, see Completing a Draft 

Goal on page 50. 

8. To continue adding the goal, click on More Details. 

 

9. Click on the Measurement triangle to expand the measurement section. 

 

10. Click on the Type pulldown menu and select the type of measurement that will be used to 

measure success. 
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11. Enter a name for the measurement. 

 

12. If the measurement is quantitative, complete the following fields (if the measurement is 

qualitative, skip this step): 

 Target Type – indicate whether the target is a “no greater than” (Maximum) value, or a 

“no less than” (Minimum) value. 

 Target Value – enter the numerical value of the qualitative measurement 

 Actual Value – leave blank initially (unless you already have measurable data for the 

goal). Enter the actual value as you begin to achieve measurable results. 

 Unit of Measurement – indicate whether the target value is a Currency, a quantity 

(Number), or a Percentage. 

 

13. Enter any necessary comments to clarify the measurement. 

 

14. In the Success Criteria field, enter an explanation of how you have accomplished this 

development goal and a summary of how your individual tasks were accomplished. To 

ensure that it is clear who wrote the comment, add your initials after the comment. 

 

15. Use the Level pulldown menu to select Stretch or Target. 

 Stretch – difficult or complex goals that are outside what is normally expected. 

 Target – goals that fall under normal job responsibilities. 
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16. Use the Category pulldown menu to select the type of company goal that is supported. 

 

17. Click on Submit (in the upper-right corner). 

 

18. Click on OK to confirm. You receive an email indicating that the goal has been forwarded to 

your manager for approval. 

You receive another email notification after your manager either approves or rejects your 

development goal. 

Editing a Development Goal 

You can make changes to or update the development goals in your goals list. Changes that you 

make are forwarded to your manager for approval. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 
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2. Click on Goals. 

 

3. Click on the Development Goals tab. 

4. Click on the goal you want to edit. 

 

5. Make the necessary edits. 

Note: When a goal is complete, enter the date it was completed in the Actual Completion 

Date field. If the goal is ongoing, the completion date is the end of the rating period. 

6. Click on Submit (in the upper-right corner). 

 

7. Click on OK to confirm. You receive an email indicating that the edit has been forwarded to 

your manager for approval. 

You receive another email notification after your manager either approves or declines your 

edit. 
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Note: If the only edits you made were to the Measure-specific Comments field or to the 

success criteria Comments field, your manager is not notified. 

Deleting a Development Goal 

You cannot delete development goals that were assigned to you, but you can delete goals that you 

added. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

2. Click on Goals. 

 

3. Click on the Development Goals tab. 
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4. Highlight the goal you want to delete. (Do not click on the name of the goal, just highlight it.) 

 

5. Use the Actions pulldown menu to select Delete. 

 

6. Click on Yes to confirm that you want to delete the goal. 

 

7. Click on OK to confirm. The request to delete the goal is sent to your manager for approval. 

The goal remains on your list until it is approved for deletion by your manager. 
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Performance Management 
Performance management is the process of administering and recording your manager’s evaluation 

of your performance. 

Performance Management Overview 

The evaluation cycle begins with an email with a subject line of “FYI:Performance Notification 

Upcoming Performance Review.” The following paragraphs provide a brief overview of the process. 

1. After you receive the email, create the Performance Document as described in Creating 

Your Performance Document on page 71. Both you and your manager work to create the 

document. 

2. After the Performance Document is created, you can request feedback from coworkers as 

described in Requesting Participant Feedback on page 74. Your manager may also request 

feedback from additional employees that you have worked with. 

3. You can begin your self-evaluation as described in Performing Your Self-Evaluation on 

page 78. You will provide a summary of your accomplishments and challenges and then 

rate yourself. When your self-evaluation is complete, your manager creates the evaluation 

and then submits it to their manager. 

4. After the evaluation has been submitted, you meet with your manager to discuss the 

evaluation. Ratings are not provided during this meeting. After the meeting, your manager 

confirms that the meeting occurred, and then you do the same. 

 

  

1 

2 

3 

4 



PERFORMANCE MANAGEMENT:  CREATING YOUR PERFORMANCE DOCUMENT  

 71 HRIS – Employees’ User Guide

5. After you have both confirmed the meeting, your manager submits the ratings for approval 

to their upline manager. After their manager has approved the ratings, they share the ratings 

with you. You acknowledge the Performance Document and share your feedback as 

described in Acknowledging Your Performance Document and Sharing Feedback on page 

86. After your manager shares (submits) yours and their feedback, the evaluation cycle is 

complete. 

 

Creating Your Performance Document 

The evaluation cycle begins when you receive an email with a subject line of “FYI:Performance 

Notification Upcoming Performance Review.” Before evaluations can begin, you must create the 

performance document and set your goals. 

 

Note: As you create your performance document, you can click on Share to provide your manager 

with access to the document. 

 

1. Open the email and click on the Open Performance Overview link. 
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2. Login to HRIS. Your Evaluations page is displayed. (You can also access the Evaluations 

page by clicking on Navigator > My Information > Performance.) 

Throughout the review cycle process, your next task is always indicated. 

 

Note: If you do not see the performance document you are looking for, click on Search 

Performance Document and enter either “ULC” (for US or UK) or “BPO” (for India) 

and then click on Search. 

 

 

3. Click on the triangle to expand the review cycle tab. 

 

4. All of the steps in your evaluation process are displayed. Click on Begin (across from Set 

Goals). 
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5. Unless instructed otherwise, leave the default start and end dates. Click on Continue. 

 

6. Click on OK to confirm. The performance document is created. 

Your manager is notified via email that the document has been created. 

7. Review your Performance Document to ensure that the goal information is correct. Do not 

change or add goals in the Performance Document. (If you edit a goal or add a new goal 

within the Performance Document, the change does not flow back to the goals section.) If 

edits need to be made, refer to Updating Goals or Importing New Goals to Your 

Performance Document on page 74. 

8. Check your goal weights in the upper-right corner to ensure they are correct and add up to 

100%. If the weights are correct, skip to step 12. If you need to edit the weights, continue 

with step 9. 

 

9. Click on the goal whose weight you want to change. The currently selected goal is bolded. 

 

10. Click on the Weights triangle to expand. 
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11. Enter the correct weight in the Weight field. 

 

12. If necessary, repeat this process for additional goals. 

13. When all your goals appear to be up-to-date, click on Submit (upper-right corner). 

 

14. Click on Yes > OK to confirm. 

Your manager is notified via email that your goals have been set. 

Updating Goals or Importing New Goals to Your Performance Document 

If you add a new goal or update an existing goal (in the goal management section of HRIS) after 

your performance document has been created, you must use Update Goals and Competencies or 

Import Goals and Competencies to update the goals in the performance document. 

 Import Goals and Competencies – adds new goals to the performance document. 

 Update Goals and Competencies – changes existing goals, competencies, or other goal 

details. 

Caution: Go to the goal management section of HRIS to edit your goals or add new ones. If you 

edit goals or add new goals within the performance document, the change does not flow 

back to the goals section. 

1. After adding or updating a goal or goals, use the Actions pulldown menu to select Import 

Goals and Competencies or Update Goals and Competencies. 

 

2. Click on OK. 

3. A confirmation window appears. Click on OK. 

Goals in your performance document are updated, or new goals that you have added are 

imported into your performance document. 

Requesting Participant Feedback 

You can request feedback from other employees that you have worked with during the review cycle. 

The employee completes a questionnaire, which is then forwarded to your manager. You will not be 

able to view the feedback. 
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You can request participant feedback any time after the performance document is created. 

1. From the My Evaluations page, click on the triangle to expand the review cycle tab. 

 

2. All of the steps in your evaluation process are displayed. Click on Begin (across from 

Manage Participant Feedback). 

 

3. The Manage Participant Feedback page is displayed. Click on Add Participants. 
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4. The Add Participants window is displayed. Use the Relationship to Worker pulldown 

menu and select the relationship that the participant has with you. 

 Peers – Employee who reports directly to your manager. 

 All Internal – All UnitedLex/iRunway employees. 

 Matrix Managers – Project managers to whom you report for specific projects. This is 

applicable only if a Matrix Manager(s) has been defined for you in Fusion. 

 

5. Use the Name field to select the person to whom you want to provide feedback, or click on 

Search… to search for employees that are not in the pulldown menu. 

 

6. Click on Add to add the employee’s name to the list of participants. 

 

7. Use the Role pulldown menu to select the feedback role that the participant is performing. 

This field determines the type of questions that are provided to the participant. A “Managee” 

is one of your direct reports. 
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8. Repeat steps 4 through 7 to add additional participants. 

9. When you have finished selecting participants, click on Save and Close. 

 

10. Highlight one or more participants to whom you want to send the request. 

 

11. Click on Send Requests. 

 

12. Use the Calendar pulldown icon to select the due date. 

 

13. Enter any message you want to provide to the participants. 
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14. Click on OK. 

 

15. Click on OK to confirm. An email notification is sent to the participants. 

Providing Feedback for Other Employees 

When another employee requests feedback from you, you receive an email with a subject line of, 

“FYI:You are Requested to Provide Feedback for [Requester Name].” 

 

1. Open the email and click on Provide Participant Feedback. 

 

2. Login to HRIS. The Feedback Questionnaire is displayed. Provide feedback by filling out the 

form. 
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Note: If you need to save the form and complete it later, you can click on Save or Save and 

Close (located in the upper-right corner) at any time. To reopen the feedback, see 

Opening a Saved Feedback Form on page 80. 

 

3. If necessary, you can provide attachments for some of the questions. 

 

4. When you have completed your feedback, click on Submit (located in the upper-right 

corner). 
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Opening a Saved Feedback Form 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 

2. Under My Information, click on Performance. 

 

3. Click on the My Feedback Requests tab. 

 



PERFORMANCE MANAGEMENT:  PERFORMING YOUR SELF-EVALUATION  

 81 HRIS – Employees’ User Guide

4. Click on Continue. 

 

5. Continue filling out the feedback form. 

Performing Your Self-Evaluation 

Once your goals are set by your manager, you can perform your self-evaluation, which will be 

forwarded to your manager. You are notified via email when you can begin your self-evaluation. 

You must rate yourself (and provide comments) for all goals. You then provide an overall summary, 

consisting of a rating and supporting comments. 

While preparing your self-evaluation, you can click on Save or Save and Close to close the 

evaluation and return to it later. 

 

1. From the My Evaluations page, click on the triangle to expand the review cycle tab. 
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2. All of the steps in your evaluation process are displayed. Click on Begin (across from 

Worker Self-Evaluation). 

 

3. Select the first goal that you want to evaluate. The currently selected goal is bolded. 

 

4. If the Worker tab is not already open, click on the triangle to open it. 
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5. Use the Performance Rating pulldown menu to select what you believe your performance 

rating should be for this goal (1 = lowest; 6 = highest). 

 

Note: To view a description of what the ratings mean, click on the Performance Rating 

Descriptions triangle. 

 

6. Enter detailed text in the comments section to justify your rating. Comments must be 

provided for all goals. 

 

7. Repeat steps 3 through 6 until all goals have ratings and comments. 
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8. When all goals have been rated, click on the Overall Summary tab. The calculated average 

of your ratings is displayed. 

 

9. Use the Worker Overall Rating pulldown menu to select what you believe your overall 

rating should be. This rating should equal or be close to your Calculated Rating. 

 

10. Enter detailed text in the comments section to justify your rating. 
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11. When you are ready to submit your self-evaluation to your manager, click on Submit 

(located in the upper-right corner). 

 

12. Click on OK to confirm. Your manager is notified via email that you have completed your 

self-evaluation. 

Confirming Your Review Meeting with Your Manager 

After your manager submits your performance document to their manager for approval, your 

manager schedules a meeting with you to discuss your evaluation. The actual ratings are not 

presented during this meeting, just general feedback concerning your performance. 

After the meeting, your manager confirms that the meeting was held. You will receive an email with 

a subject line of “FYI:Review Meeting held for BPO (or ULC) Annual Performance Review [Rating 

Year].” 

 

1. Open the email and click on the Open Performance Overview link. 

 

2. Login to HRIS. The Evaluations page is displayed. Click on Confirm Review Meeting Held. 

 

3. Click on Yes to acknowledge that the review meeting was held. 
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4. Click on OK to confirm. Your manager is notified via email that you have confirmed that the 

meeting was held. 

Acknowledging Your Performance Document and Sharing Feedback 

After your performance document ratings have been approved, your manager can share your 

ratings with you. 

After the ratings are shared, you receive an email with a subject line of “FYI: BPO [or ULC] Annual 

Performance Review 15-16 is Ready for Review.” 

 

1. Open the email and click on the Open Performance Overview link. 

 

2. Login to HRIS. The Evaluations page is displayed. (You can also access the Evaluations 

page by clicking on Navigator > My Information > Performance.) 

3. Click on Acknowledge and Provide Final Feedback. 

 

Your overall Performance Rating is displayed. 
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4. Click on the Goals tab to view your ratings for your individual goals. 

 

5. Click on a goal to view yours and your manager’s rating and comments. (The bolded goal is 

the goal that is currently selected.) 

 

6. Click on the Overall Summary tab to view your ratings for your individual goals. 

 

Yours and your manager’s overall comments and rating are displayed. 
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7. Click on the Employee Final Feedback tab, and provide your final feedback. 

 

8. When you are ready to submit your feedback and acknowledgement to your manager, click 

on Submit (located in the upper-right corner). 

 

Click on Yes > OK to confirm. Your manager is notified via email that you have provided 

final feedback. 

Your evaluations page indicates that you have no more tasks to perform for this evaluation. 

 

Viewing Past Performance Documents 

You can view past performance documents, but you are not able to edit them. 

1. From the Welcome Screen (or the horizontal bar of other screens), click on Navigator. 

 

Your Dashboard is displayed. 
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2. Under My Information, click on Performance. 

 

3. Click on Search Performance Document. 

 

4. Enter appropriate search criteria, such as site abbreviations ULC or BPO, and then click on 

Search. 

 

5. If the Performance Document is not displayed, it may be necessary to click on Load More 

Items to view additional Performance Documents. 
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Interviewing Job Candidates 
To interview job candidates, you must accept an invitation, interview the candidate, and then 

provide an assessment of the candidate. 

Accepting or Declining a Request for an Interview 

The Talent Acquisition department initiates interviews within HRIS. You are notified via email that 

an interview is scheduled to which you are invited. 

 

1. Open the email and click on Interview URL. 

 

The Interview Information is displayed. 

 

2. Select Accept, Decline, or Request Reschedule, and click on Submit. If you click on 

Decline or Request Reschedule, enter an explanation in the comments field. 
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After you have submitted your response, you receive an interview confirmation email. 

3. To add the meeting to your MS Outlook Calendar, double-click on the Confirmation.ics file 

attached to the interview confirmation email. 

 

Completing an Assessment Sheet 

After the interview is complete, you will be sent an email containing a link to the assessment form, 

which you will use to provide your evaluation of the candidate’s interview. 

1. Open the assessment email. 

 

A link to the assessment form is displayed, along with a due date for the assessment. 

Note: To add the due date to your MS Outlook Calendar, double-click on the 

Confirmation.ics file attached to the assessment email. 

 

2. Click on the link to the assessment form. 
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The Technical Assessment Form is displayed. Questionnaire Information provides 

definitions of the ratings (1 through 5). 

 

3.  Use the pulldown menus to enter the type and date of the interview. 

 

4. Use the pulldown menus to provide ratings for the first category. If applicable, provide 

justification for your ratings in the Comment fields. Repeat the process for all categories. 
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5. When all categories have been rated, select your recommendation regarding the status of 

the interviewee and provide comments in the field below. 

 

Note: Prior to the final interview, use the “Shortlisted for the next round” option to continue 

to consider a candidate (not the “Hire option). The “Hire” option should be used only 

by the hiring manager after the last round of interviews.  

6. Enter your overall recommendation for the interviewee. 

 

7. When you have completed your evaluation, click on Save. 

Note: After you click on Save, you cannot access or edit your assessment. 

A confirmation window indicates that you have completed the assessment. You also receive 

an email notification. 
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Applying for an Internal Job Posting 
You can use HRIS to apply for a UnitedLex internal job posting (IJP). 

While completing the application, you can click on Save and Continue or Save as Draft at any 

time to save your work. 

 

1. Go to the appropriate website: 

 UnitedLex - https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl? 

 iRunway - https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl? 

2. Click on Sign In. 

 

3. Enter your HRIS (Taleo) user name and password and click on Login. 

If you have not created your IJP login credentials, refer to Creating a Password for Internal 

Job Postings or Referring a Candidate on page A-2. 

 India – Sunil Kumar (+91-9818637887) 

 US – Shweta Bhatia (913-209-4820) or James Wareham (913-333-3437) 

 

https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl?
https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl?
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4. A list of the current UnitedLex job openings is displayed. Click on the job in which you are 

interested to view details of the position. 

Note: To ensure you are seeing all the latest postings, press F5 or click on View All Jobs in 

the upper-right corner. It is also a good idea to occasionally clear your cache, as 

described in the Appendix, Deleting Your Browser History on page A-5. 

 

A brief job description is displayed. 

Note: If you want to store a job so that you can compare several jobs, or if you want to apply 

for more than one job, click on Add to My Job Cart. To go back to your job cart, click 

on My Job Cart in the upper-right corner. Jobs stored in your job cart expire after the 

duration for which an internal job posting concludes. 

   

5. If you want to apply for the position, click on Apply Online. 
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6. Read the Privacy Agreement and click on I Accept. 

 

Uploading a Résumé 

You can upload a résumé in a Word or PDF format. If you have already uploaded your résumé, you 

can skip to the following section (Manually Complete an Online Submission). 

1. Select Select the resume file to upload and then click on Browse…. 

 

Note: The Profile Upload option allows you to upload your résumé from LinkedIn. However, 

you cannot use this option if you are connecting to the job site through the UnitedLex 

or iRunway network. 

2. Browse to your résumé and click on Open. 

3. Click on Save and Continue. 

Note: If you later apply for a different position, you will not have to reload your résumé. 

Manually Complete an Online Submission 

Note: If you have previously applied for a position or have uploaded a résumé, your personal 

information is automatically loaded and you need only check the fields and edit if necessary. 

1. Select No thanks, I will fill out the online submission manually. 

2. Click on Save and Continue. 
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3. Enter the required fields in the Personal Information section (indicated by *). 

Note: The City field refers to your residence, not your current work location. 

Note: The Roles in ULX field refers to current job title or function. 

 

4. Optionally, enter your work and/or cell phone numbers. If you select either Work Phone or 

Cellular Phone, you must enter the number for that phone in the appropriate field. You may 

also enter your employee number (which is the same as your HRIS login name), and your 

current salary. 

5. Click on Save and Continue. 
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6. Enter at least the required fields in the Job Posting Notification and Education sections 

(indicated by *). 

 

Note: To add additional schools you attended, click on Add Education. 

7. Click on Save and Continue. 
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8. Answer the four questions in the Questions About Me section. All questions must be 

answered. 

 

9. Click on Save and Continue. 

10. If Additional Questions are displayed, you must answer all of them. 

 

Note: Additional Questions includes prescreening questions and competencies. If these 

questions and competencies are not part of the job posting, this page does not 

appear. 

11. Click on Save and Continue. 
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12. Enter all required fields concerning your work experience. If applicable, click on Add Work 

Experience to add additional relevant jobs. 

 

Note: If you select Current Job, leave the End Date blank. If you do not select Current 

Job, enter the date that the job ended. 

13. When finished, click on Save and Continue. 
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14. If you have files, such as a résumé, cover letter, transcripts, etc. click on Browse… and 

browse to and attach the file. If the file is a résumé, select the Résumé box. 

 

Note: If you previously attached your résumé, it is already shown in the area at the bottom 

of the screen. 

15. The Summary section is displayed. If anything needs to be changed, click on Edit in the 

appropriate section. 

 

16. If everything is correct, click on Submit.  

 

You receive an email verifying that your submission was received. 
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Referring a Candidate for a Job Posting 

1. Go to the appropriate website: 

 UnitedLex - https://unitedlex.taleo.net/careersection/ulxinref/jobsearch.ftl? 

 iRunway - https://unitedlex.taleo.net/careersection/ulxirinref/jobsearch.ftl? 

2. Enter your user name and password and click on Login. 

If you have not received your login credentials (or have forgotten your user name), email 

HRIS Support at HRIS@unitedlex.com, or contact your system administrator. 

 India – Sunil Kumar (+91-9818637887) 

 US – Shweta Bhatia (913-209-4820) or James Wareham (913-333-3437) 

 

A list of the current UnitedLex job openings is displayed. 

3. Click on the job for which you want to make a specific referral. 

 

https://unitedlex.taleo.net/careersection/ulxinref/jobsearch.ftl?
https://unitedlex.taleo.net/careersection/ulxirinref/jobsearch.ftl?
mailto:HRIS@unitedlex.com


REFERRING A CANDIDATE FOR A JOB POSTING:  MANUALLY COMPLETE AN ONLINE SUBMISSION  

 103 HRIS – Employees’ User Guide

Note: If you want to refer a candidate for consideration, but don’t see a current, specific 

posting, click on UConnect located at the bottom of the page. 

 

4. The Job Details page is displayed. Click on Refer a Friend. 

 

5. The About Yourself window is displayed. Required information is auto populated. Optionally, 

you can edit or add additional information to the fields. 

After entering your information, click on Save and Continue. 
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6. Enter the email address of the person being referred, and click on Save and Continue. 

 

7. Write a brief description of what makes the referral a good candidate, and click on Save and 

Continue. 
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8. The About Your Referral window is displayed. The email address is auto populated. Add 

additional information to the required fields. After you select their Primary Number type, you 

must enter the number for that phone in the appropriate field. 

Optionally, you can enter alternate phone numbers and their address. 

After entering the referral’s information, click on Save and Continue. 

 

9. If you have files, such as a résumé to attach, click on Browse…, browse to and select the 

file. Click on Attach and then Save and Continue. 
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10. The summary page is displayed. If you want to edit an item, click on Edit. If everything is 

complete, click on Submit. 

  

The process is complete. Both you and the person you have referred receive a notification 

email. 
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Appendix 

HRIS Links and Logins 

There are 2 main applications comprising HRIS – Fusion and Taleo. Your user name on both 

sites is the same, but your passwords may be different. When you change a password on one 

application, it does not change the password on the other application. 

Fusion Links and Logins 

Fusion contains the “core” HR functions of HRIS. The following are some of the tasks performed 

in Fusion: 

 Viewing/editing your personal information, including emergency contacts, email 

addresses, and phone numbers 

 Viewing compensation 

 Viewing and requesting absences (only for salaried employees in UnitedLex Corp and all 

UK employees) 

 Viewing the UnitedLex directory 

 Changing marital status 

 Accessing UnitedLex social network 

The Fusion login site is https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome. 

 

https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome
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Taleo Links and Logins 

Taleo contains functions such as recruiting and internal job applications. The Taleo login site is  

https://unitedlex.taleo.net. 

 

Job Postings Links and Logins 

There are two ways to apply for UnitedLex or iRunway job postings, using either the internal 

website or the external website. For more information about applying for internal postings, see 

Applying for an Internal Job Posting on page 94. 

Creating a Password for Internal Job Postings or Referring a Candidate 

In order to apply for an internal job posting, or to refer a candidate for a position, you must 

create an additional Taleo password that is used to access either of these functions. 

1. Go to the appropriate website. 

 UnitedLex - https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl? 

 iRunway - https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl? 

2. Click on Sign In. 

 

https://unitedlex.taleo.net/
https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl?
https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl?
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3. Enter your User Name and click on Forgot your password?. 

 

4. Enter your email address and click on OK. 

 

A message is displayed, indicating that an email has been sent to you. 

5. Open the email and complete the steps to create a password that can be used to both 

apply for an internal job posting and to refer a candidate. 

 

Internal Website 

If you are connected to the UnitedLex network, either directly or by VPN, you can go to 

 UnitedLex - https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl? 

 iRunway - https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl? 

Use your IJP user name and password to login. 

https://unitedlex.taleo.net/careersection/ulxinijp/jobsearch.ftl?
https://unitedlex.taleo.net/careersection/ulxirinijp/jobsearch.ftl?
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External Website 

If you are not connected to the network, you can apply the same as an external candidate. Use 

one of the following links: 

 iRunway - https://unitedlex.taleo.net/careersection/ulxirin/default.ftl. 

 UnitedLex - https://unitedlex.taleo.net/careersection/ulxexin/default.ftl. 

You do not need to login initially, but can create your own user account, including a user name 

and password. 

  

https://unitedlex.taleo.net/careersection/ulxirin/default.ftl
https://unitedlex.taleo.net/careersection/ulxexin/default.ftl
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Troubleshooting 

Deleting Your Browser History 

Internet browsers use caches of websites you have previously visited to make subsequent visits 

to the same website faster. However, as these caches continue to grow over time, your PC can 

become bogged down and sometimes the latest data for a site may not be displayed, so you 

may want to occasionally empty those caches. 

Internet Explorer 11 

Note: Other versions of IE use a similar process. 

1. Open Internet Explorer and click on the Tools icon  in the upper-right corner of your 

browser window. 

 

2. Select Safety > Delete browsing history…. 
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3. Select Temporary Internet files and website files. and Cookies and website data. 

 

4. Click on Delete. 

Google Chrome 

1. Click on the Chrome menu icon  in the upper-right corner of your browser and select 

More Tools. 
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2. Click on Clear browsing data…. 

 

3. Select the beginning of time and then select the items you want to delete 

 

Click on Clear browsing data. 

Fusion – Blank Screen 

If you get a blank screen after clicking on your Fusion bookmark, you may need to replace the 

Fusion login URL with the following link: 

https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome 

After performing the following procedure, you should not have to repeat it. 

1. After creating a bookmark for the Fusion login screen, click on your Favorites icon  

 

https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome
https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome
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2. Right-click on the Fusion Login bookmark and select Properties. 

 

3. Highlight the bookmark’s URL and delete it. 

 

4. Copy and paste the following URL or enter it into the URL field. 

https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome 

 

5. Click on OK. 

https://hcek.hcm.us1.oraclecloud.com/hcmCore/faces/HcmFusionHome

	HRIS Core Function
	Logging In
	Getting Started
	Changing Your Time Zone
	Viewing and Editing Personal Information
	Viewing Your Compensation
	Viewing Leave/Paid Time Off (PTO)/Absence Balances – US/UK
	Requesting Leave, PTO, or Other Types of Absences
	Deleting an Absence Request

	Absence Management - India Employees
	Viewing Leave, Attendance Regularization, and Absence Balances
	Requesting Leave, Earned Leave, Causal Sick Leave, or Other Types of Absences
	Deleting an Absence Request

	Requesting Attendance Regularization on No Bio Metric Days
	Using the Availability Calendar
	Important Points Concerning Absence Management

	Viewing the UnitedLex Directory
	Editing Your Email and Phone Information
	Changing Your Marital Status

	Goal Management
	Performance Goals
	Viewing and Adding a Performance Goal
	Searching the Goal Library
	Accepting a Shared Goal

	Editing a Performance Goal
	Deleting or Cancelling a Performance Goal

	Sharing a Goal
	Completing a Draft Goal

	Tasks
	Viewing and Adding a Task
	Editing a Task
	Deleting a Task


	Development Goals
	Viewing and Adding a Development Goal
	Editing a Development Goal
	Deleting a Development Goal



	Performance Management
	Performance Management Overview
	Creating Your Performance Document
	Updating Goals or Importing New Goals to Your Performance Document

	Requesting Participant Feedback
	Providing Feedback for Other Employees
	Opening a Saved Feedback Form

	Performing Your Self-Evaluation
	Confirming Your Review Meeting with Your Manager
	Acknowledging Your Performance Document and Sharing Feedback
	Viewing Past Performance Documents

	Interviewing Job Candidates
	Accepting or Declining a Request for an Interview
	Completing an Assessment Sheet

	Applying for an Internal Job Posting
	Uploading a Résumé
	Manually Complete an Online Submission

	Referring a Candidate for a Job Posting
	Appendix
	HRIS Links and Logins
	Fusion Links and Logins
	Taleo Links and Logins
	Job Postings Links and Logins
	Creating a Password for Internal Job Postings or Referring a Candidate
	Internal Website
	External Website


	Troubleshooting
	Deleting Your Browser History
	Internet Explorer 11
	Google Chrome

	Fusion – Blank Screen





